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Which Tutorial is Right for Me?

A number of tutorials for learning about Sentinel LDK are available. We recommend that you review the
information below to ensure that you choose the tutorial that is most appropriate for your requirements.

All the tutorials are included in the Sentinel LDK Demo kit and Starter kit.

Software Protection and Licensing Tutorial — Sentinel SL (Software-based) Keys
This tutorial demonstrates how to protect and license an application with Sentinel SL (software) protection keys.
Requirements: Download the free Sentinel LDK Demo Kit. No hardware keys are required to perform this

tutorial.

NOTE The remaining tutorials described below demonstrate how to protect and license an
application with either Sentinel SL (software) or Sentinel HL (hardware) protection keys.

Software Protection and Licensing Tutorial — “Demo Kit” or “Starter Kit”

Sentinel LDK-EMS (Entitlement Management System) is used as the back office system to manage definition of
Features and Products and to generate and track customer entitlements.

> The Demo Kit tutorial uses a provided demonstration hardware key.

Requirements: Obtain the free physical Sentinel LDK Demo Kit from your Thales sales representative or
from the Thales web site.

> The Starter Kit tutorial uses your own Sentinel Developer key and Sentinel HL key to protect and license an
application.

Requirements: Purchase the Sentinel LDK Starter kit and Sentinel HL protection keys from your Thales
sales representative.

Software Protection and Licensing API Tutorial — “Demo Kit” or “Starter Kit”

These tutorials demonstrate how you can use Sentinel LDK APIs to generate and update licenses. Itis assumed
that you would use your own back office systems to handle all ERP functionality.

A Demo Kit tutorial and a Starter Kit tutorial are available as described above.
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Introduction

Thank you for choosing Sentinel License Development Kit (Sentinel LDK) as the method to protect and license
your software against unauthorized use. In this Tutorial, you use the Sentinel LDK system to protect, license, and
distribute software.

The strength, uniqueness, and flexibility of Sentinel LDK are based on two primary principles:

Protect Once—Deliver Many—Evolve Often™: the concept of separating the software engineering and business
processes

Cross-Locking: the technology that supports the Protect Once—Deliver Many—Evolve Often concept, enabling
a protected application to work with a Sentinel HL (hardware) or a Sentinel SL (software) key

All commercial decisions, package creation, and license definitions are executed by product or marketing
managers after the protection has been implemented.

This workflow model provides you with greater flexibility and freedom when defining new sales and licensing
models, including feature-based and component licensing, evaluation, rental, floating, subscription, trialware
(trial/grace), pay-per-use, and more, enabling you to focus on revenue growth.

Sentinel Keys

You will use the following Sentinel keys to perform the lessons in this tutorial:

> Sentinel Developer key (yellow), used to protect your programs

> Sentinel Master key (blue), used for license production. (Used for on-premises installations of Sentinel LDK-
EMS only. If you have subscribed to LDKaa$, store the Master key in a safe location.)
For on-premises installations of Sentinel LDK-EMS, the Sentinel Master key must stay connected to the
Sentinel LDK-EMS Server machine.

NOTE The Sentinel Developer key and Sentinel Master key are included in the Starter Kit.
These key are referred to as Sentinel Vendor Keys.

> One or more end-user Sentinel HL keys, used to run the protected program (color depends on key type).
Sentinel HL keys were ordered separately and are provided in a separate package.

This tutorial is only partially applicable for Sentinel HL Basic keys. Sentinel HL Basic keys can be used only to
protect your programs, and not to set licensing terms.
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Introduction

Roles

The Sentinel LDK system is role-based, and the tasks you can perform depend on the user roles assigned to you
by the Sentinel LDK Administrator.

In order to enable you to experience the broad functionality of the Sentinel LDK system in this tutorial, you will
have access to all roles. The roles you assume in the various lessons include:

>

Product Manager role

The person, usually a product manager, who determines the product components to be protected (called
Features in Sentinel LDK), how these components are used to define Products, and the license structure for
the Products.

Development role

The person, usually a software engineer, who protects the software using Sentinel LDK Envelope or the
Sentinel Licensing API, and performs other development-related tasks, such as generating the Sentinel Run-
time Environment Installer.

Customer Services role

The person responsible for performing manual Product activations.

Entitlement Manager role

The person responsible for defining and managing customer entitlements (orders).
Production role

The person responsible for producing customer entitlements.

In addition, you will assume the role of an end user in order to test, use, and update the products licensed using
Sentinel LDK.

Conventions

Each of the lessons in this tutorial begins with a focused breakdown of the lesson, similar to the following:

Objective: A short description of the lesson objective
Roles in this lesson: The role or roles that you assume during the lesson
Applications used: Sentinel LDK applications that you use in the lesson
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Introduction

Lessons in This Tutorial

This tutorial is based on a Windows operating system and includes the following lessons:

>

" Preliminary Preparation" on page 10 — In this lesson, you install the Sentinel LDK system and learn how to
launch Sentinel Vendor Suite. You then introduce your Sentinel Master key and Sentinel Developer key into
the Sentinel LDK system.

"Defining Features" on page 14 — In this lesson, you use Sentinel LDK-EMS to define two programs as
Features, which you will later license and protect.

"Protect Once" on page 17 — In this lesson, you use Sentinel LDK Envelope to apply protection to your
software.

"Defining Products" on page 21 — In this lesson, you use Sentinel LDK-EMS to define your offering by defining
Products based on the Features you already defined and protected.

"Defining an Unlocked Trialware Product" on page 25 — In this lesson, you use Sentinel LDK-EMS to define
an Unlocked Trialware Product based on one of the Products you defined, enabling you to distribute a trial
version of your software later.

"Creating and Distributing an Entitlement for Sentinel SL-protected Software" on page 28 — In this lesson, you
lock your protected software to a Sentinel SL key for later distribution. You will create an entitlement, define a
customer, code the Sentinel SL key, and use the software as an end user. You will also learn how to activate
a license, in order to convert the trial version of a program to a full-featured program.

"Creating and Distributing an Entitlement for Sentinel HL-protected Software" on page 33 — In this lesson, you
lock your protected software to a Sentinel HL key for later distribution. You will create an entitlement, define a
customer, code the Sentinel HL key, and use the software as an end user. You will also learn how to create a

license update for a deployed Product that has its license locked to a Sentinel HL key.

"Using Sentinel Licensing API" on page 39 — In this lesson, you learn how to program the memory on Sentinel
protection keys.

We recommend that you follow the lessons sequentially to familiarize yourself with the Sentinel LDK system and
to gain a clear understanding of the strength of the Protect Once—Deliver Many—Evolve Often model, and the
flexibility it provides.

Additional Resources

You can use the following resources to help you learn about the Sentinel LDK system:

>

Sentinel LDK Software Protection and Licensing Guide

This book describes Sentinel LDK licensing concepts and provides a detailed overview of the system.
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Introduction

> Sentinel LDK Release Notes

The Release Notes provide information about the current release, including:

latest enhancements

e supported platforms

available documentation

known issues
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LESSON 1: Preliminary Preparation

Objective: Prepare your computer and Sentinel LDK for the tutorial

Applications used: > Sentinel LDK installation package
> Sentinel Master Wizard
> Sentinel Vendor Suite

The procedures in this lesson are required in order for you to be able to implement the processes outlined in
subsequent lessons of this tutorial. They include:

> Instructions for installing the Sentinel LDK software, including Sentinel LDK-EMS Server

> Instructions for launching Sentinel Vendor Suite
> Instructions to confirm that your Sentinel LDK Master License contains the required modules for the tutorial.
> Instructions for introducing the Sentinel Vendor keys to the Sentinel LDK system

Installing the Sentinel LDK Software

Before proceeding with this tutorial, install the Sentinel LDK software on your computer.

CAUTION! Do not connect any of your Sentinel keys before installing the Sentinel LDK
software!

For instructions on how to install Sentinel LDK-EMS and Sentinel LDK Vendor Tools, refer to the section
“Installing Sentinel LDK With Sentinel LDK-EMS (On-Premises)” in the Sentinel LDK Installation Guide.

If you have subscribed to Sentinel LDK-EMS hosted by Thales, refer to the section “With Sentinel LDK-EMS
(Hosted By Thales)” in the Sentinel LDK Installation Guide.

During the installation procedure, you can accept most defaults.
When prompted for Installation Options, select:
> Vendor Suite
> Entitlement Management System
* Sentinel LDK-EMS - install on this machine

If you have subscribed to Sentinel LDK-EMS hosted by Thales, for Entitlement Management System, choose:
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Lesson 1: Preliminary Preparation

* Sentinel LDK-EMS - hosted by Thales or on your network

When prompted to choose a setup type for Sentinel LDK-EMS, click the Express option.

Starting the Sentinel LDK Launcher

After completing the installation, launch Sentinel Vendor Suite as follows:

1. In the Windows Services window, ensure that the Sentinel LDK-EMS Service is active

2. From the Start menu, open Sentinel LDK. The Sentinel LDK Launcher is displayed. You can access the
primary Vendor Suite applications from this screen.

Checking the Required Modules on the Sentinel LDK Master
License

To perform all of the lessons in this tutorial when working with your organization's Batch Code, your Sentinel LDK
Master License must contain the following modules:

> Product Activation module - must not be expired.

If your organization did not order this module, a new installation of Sentinel LDK provides a 30-day trial
license for the module.

> New SL Key Pool - must not be expired or must contain a value greater than 0.

If your organization did not order this module, a new installation of Sentinel LDK provides 15 units for the
module.

> Unlocked Trialware module - must not be expired.

A trial license for this module is not provided.

To determine the status of the modules on your Sentinel LDK Master License:

1. Ensure that your Master key is connected to the machine.
2. Inthe Sentinel LDK Launcher, click Sentinel LDK-EMS.

3. Inthe User ID and Password fields, type admin. Click Login.

NOTE The firsttime you log in to Sentinel LDK-EMS, you must change the default password for
the admin account. You can also change this password at any time from the top-right corner of
Sentinel LDK-EMS.

4. In Sentinel LDK-EMS, select the Administration tab, and then select the Master tab.

(3]

. Select your Batch Code from the Batch Code list.
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Information regarding your Master License is displayed. Check the status of the modules described above.

> If you have the required modules, you can proceed with the tutorial using your assigned Batch Code. You
must use this Batch Code throughout the tutorial.

> If you do not have the required modules, you can proceed with the tutorial using the DEMOMA Batch Code.
For more information, see the Software Protection and Licensing Tutorial for the Demo Kit.

Introducing the Sentinel Vendor Keys

Sentinel Vendor keys (Sentinel Master key and Sentinel Developer key) enable you to apply Sentinel LDK
protection to your software and data files, to program the Sentinel protection keys that you send to your end
users, and to specify the license terms under which your software can be used.

The Sentinel Developer key is used by your software engineers in conjunction with the Sentinel LDK protection
applications to protect your software and data files. The Sentinel Master key is connected to the Sentinel LDK-
EMS Server computer and used in conjunction with Sentinel LDK-EMS for defining Features and Products,
applying license terms, and producing entitlements.

In order to complete this tutorial, you need to introduce your Sentinel Vendor keys to the Sentinel LDK system.

To introduce your Sentinel Vendor keys

1. After starting the Sentinel LDK-EMS (Tomcat) service, connect your Sentinel Developer key and your
Sentinel Master key to a USB port. (Ensure that the Sentinel Master key is connected to the Sentinel LDK-
EMS Server machine).

2. Start Sentinel Master Wizard as follows:
e From the Start menu, open Sentinel LDK. The Sentinel LDK Launcher is displayed. From Additional

Tools, select Sentinel Master Wizard.

NOTE If you open either Sentinel LDK Envelope or Sentinel LDK ToolBox, and the application
detects a new Sentinel Vendor key, the Master Wizard will launch automatically.
3. Inthe User Name and Password fields, enter the credentials for an EMS adminisrator; then click OK.
4. Accept all defaults through the completion of the wizard.
NOTE The first time the Master wizard is run for a specific Master key, Thales servers generate
and download your customized APl libraries. This process typically require about 20 minutes to
complete. However, if there is a backlog, the generation process may require up to several hours
to complete.

The generated APlIs are located in the following directory, under the appropriate subdirectory:

%HomePath%\Documents\Thales\Sentinel LDK 10.0\API\Runtime\
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Lesson 1: Preliminary Preparation

5. Click Finish to close the wizard. This process introduces the data in your key to the Sentinel LDK system and
extracts your company’s unique confidential Vendor Code.

For additional information on Vendor Codes, see "Understanding Sentinel LDK Software Protection and
Licensing" in the Sentinel LDK Software Protection and Licensing Guide.

You are now ready to start the tutorial.

NOTE Sentinel LDK-EMS provides a natification facility for your Master key. This facility can
send automatic email reminders when:

> any of the license modules on the Master key are about to expire.
> the pool of new SL keys or network seats on the Master key falls below a certain threshold.

Thales highly recommends that you configure the notification facility to send reminders as
necessary. In the Sentinel LDK-EMS screen, on the main menu, click Administration >
Master. Follow the instructions to configure email reminders.
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LESSON 2: Defining Features

Objective: Learn how to define Features
Roles in this lesson: Product Manager
Applications used: Sentinel LDK-EMS

I NOTE This lesson is not applicable for Sentinel HL Basic keys.

A Feature is an identifiable functionality of a software application that can be independently protected or
licensed. In Sentinel LDK, a Feature may be an entire application, a module, or a specific functionality such as
Print, Save, or Draw.

Features are typically defined by the Product Manager based on business decisions, and are then implemented
by the company’s software engineers.

In this lesson, you assume the Product Manager role and use Sentinel LDK-EMS to define two Features for use
in subsequent lessons.

To launch Sentinel LDK-EMS
1. From the Start menu, open Sentinel LDK. The Sentinel LDK Launcher is displayed.
2. Inthe Sentinel LDK Launcher, click Sentinel LDK-EMS.

3. Inthe User ID and Password fields, type admin.

NOTE The first time you log in to Sentinel LDK-EMS, you must change the default password for
the admin account. You can also change this password at any time from the top-right corner of
Sentinel LDK-EMS.

4. Click Login. The Sentinel LDK-EMS Home screen is displayed. Click the Catalog tab to see a typical web
screen.

Sentinel LDK-EMS web screens typically includes the following:
> Function bars, in which you select the function to perform
> Main pane, in which you view and select items

> Details pane, in which you view details of the item selected in the Main pane
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> Task buttons, which you use to perform actions
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Defining a Feature for the Sample Bouncing Ball Program

In this section, you define a Feature for an existing program, the Bouncing Ball sample program supplied with
Sentinel LDK.

To define the Bounce Feature

1. From the function bar of the Sentinel LDK-EMS screen, click Catalog > Features. The Features screen is
displayed. This screen shows the list of Features defined and displays details of the current Feature.The right
side of the screen contains task buttons for the tasks that can be performed in this screen.

Click New Feature. The Create Feature screen is displayed.
In the Feature Name field, type Bounce.

In the Feature ID field, erase the default value and type 50.

o &~ 0 Db

Click Save. The Create Feature screen closes and the “Bounce” Feature you defined is displayed in the main
pane of the Features screen.

Defining a Feature for the MyNotepad Program

In this section, you define a Feature for the MyNotepad program. You will create the MyNotepad program in
"Protect Once" on page 17.
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Lesson 2: Defining Features

To define the MyNotepad Feature

1. Inthe Sentinel LDK-EMS screen, display the Features screen.
2. Click New Feature. The Create Feature screen is displayed.
3. Inthe Feature Name field, type MyNotepad.

4. Inthe Feature ID field, erase the default value and type 10.

NOTE If a message is displayed informing you that this Feature ID is not available, do not use
a different Feature ID number. Close the Add Feature screen, and in the main pane of the
Features screen, identify Feature 10 and note its name. For the remainder of this tutorial,
continue to use Feature ID 10, with the name you noted (instead of MyNotepad).

5. Click Save. The Create Feature screen closes and the MyNotepad Feature you defined is displayed in the
main pane of the Features screen.

6. Close the Sentinel LDK-EMS browser window.
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LESSON 3: Protect Once

Objective: Learn how to apply Sentinel LDK automatic protection functionality
Roles in this lesson: Development
Applications used: Sentinel LDK Envelope

In this lesson, you use Sentinel LDK Envelope to define protection parameters for two programs, using the two
Features you defined earlier.

Sentinel LDK Envelope is an innovative, advanced solution for protecting software against illegal or unauthorized
use. The solution deters illegal access and execution of protected applications.

A deployed Sentinel LDK-protected program requires access to a Sentinel protection key in order to run. The
protected program queries the Sentinel protection key for predefined information. If the Sentinel protection key is
not present, or the information returned is incorrect, the program does not execute, or stops functioning.

Protecting the Sample Bouncing Ball Program

In this section, you launch Sentinel LDK Envelope and identify the Vendor Code with which you will protect the
software. You then define an end-user error message. Finally, you protect the Bouncing Ball program.

The Sentinel LDK Envelope window includes the following:
> Project pane, in which you select the function to perform

> Display pane, in which you select items and perform actions. The name of the pane changes to reflect the
function you selected in the Project pane—for example, in the screen below, the Display pane has the title
Programs.

> Log pane, in which Sentinel LDK Envelope messages are displayed
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B Offline

To prepare for protection

1. Connect the Sentinel Developer key.

2. From the Start menu, open Sentinel LDK. The Sentinel LDK Launcher is displayed.

3. Click Envelope to launch Sentinel LDK Envelope. The Sentinel LDK Envelope main window is displayed.
4

. Before protecting an application, Sentinel LDK Envelope must identify the correct Vendor Code. In the
Sentinel LDK Envelope Project pane, select Sentinel Vendor Code.

5. Inthe right pane of the Sentinel Vendor Code window, click Toggle connection with the Server. The Log In
to Sentinel LDK-EMS screen is displayed.

6. Enter the user name and password to log in to Sentinel LDK-EMS; then click OK. (The default user name and
password are admin —admin.) The available Vendor Codes are displayed in the Sentinel Vendor Codes
pane.

7. Select Use Vendor Code from Database, and then select the relevant Vendor Code.
NOTE Your Vendor Code file is named according to the Batch Code labeled on your Sentinel

keys. For example, if your keys are labeled with the Batch Code ABCDE, your Vendor Code file
is called ABCDE.hvc.

To protect the Bouncing Ball program
1. Inthe Sentinel LDK Envelope Project pane, select Programs.
2. Click Add Programs in the top right of the Programs pane.

The Add Programs window is displayed, showing the contents of the \VendorSuite\samples folder.
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If a different folder is displayed, browse to:
%ProgramFiles(x86)%\Thales\Sentinel LDK\VendorTools\VendorSuite\samples\
Select Win32_Bounce.exe and click Open. Win32_Bounce is now listed in the Programs pane.
In the Project pane, under Programs, select Win32_Bounce. The Display pane lists the Protection Details.
In the Name field (to the right of the Feature ID field), select Bounce from the list (the Feature that you
defined for the Bounce program in "Defining Features" on page 14).

I NOTE If you are using a Sentinel HL Basic key, select 0 in the Feature ID field.
In the Project pane, under Default Protection Settings, select Windows. The Display pane now displays
Windows - Default Protection Settings.

In the Windows - Default Protection Settings pane, decrease the number of Periodic background
checks from the default value to 5 seconds. This means that during run-time, the protected program will
check every 5 seconds to ensure that the required Sentinel HL key is connected.

In the Project pane, under Programs, select Win32_Bounce, then in the Display pane, click Protect
Selected. A message informs you that the protection process is running.

Click Close when Sentinel LDK Envelope notifies you that the protection process has completed.
The protected Bouncing Ball program is saved in this folder:

%HomePath%\Documents\Thales\Sentinel LDK 10.0\VendorTools\VendorSuite\Protected

Protecting the MyNotepad Program

In this section, you create a copy of the Thales text viewer sample application, define protection parameters for
protecting it using the MyNotepad Feature, and protect the program.

I NOTE This section is not applicable for Sentinel HL Basic keys.

To protect the MyNotepad program

1.

Locate the Thales text viewer application (textviewer.exe). This utility can be found under:
%ProgramFiles(x86) %\ Thales\Sentinel LDK\VVendorTools\VendorSuite\samples\

Create a copy of the text viewer application and rename it MyNotepad.exe.

Verify that your Sentinel Developer key is connected to your computer.

If itis not already open, launch Sentinel LDK Envelope. The Sentinel LDK Envelope main window is
displayed.

Select the program to protect:

a. Inthe Sentinel LDK Envelope Project pane, select Programs.
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b.

C.

Click Add Programs in the top right of the Programs pane.
The Add Programs window is displayed.

Navigate to the folder where MyNotepad.exe is located. Select the file and click Open. Note that a new
MyNotepad entry is displayed in the Project pane under Programs.

6. Protect the selected program:

a.

b.

In the Project pane, under Programs, select MyNotepad. The Display pane lists the Protection Details.

In the Feature ID field, type 10 (the Feature defined for the MyNotepad program in "Defining Features" on
page 14).

In the Project pane, under Default Protection Settings, select Windows. The Display pane now
displays Windows - Default Protection Settings.

In the Windows - Default Protection Settings pane, ensure that Periodic background checks is set to
5 seconds.

In the Project pane, under Programs, select MyNotepad, then in the Display pane, click Protect. A
message informs you that the protection process is running.

Click Close when Sentinel LDK Envelope notifies you that the protection process has completed. The
protected MyNotepad program is saved in this folder:

%HomePath%\Documents\Thales\Sentinel LDK 10.0\VendorTools\VendorSuite\Protected

7. Close Sentinel LDK Envelope. You are prompted to save the changes to the current project.

8. Click Save. The Save As dialog box is displayed.

9. Inthe File Name field, type Tutorial and click Save.The dialog box closes and the project is saved.

Sentinel LDK 10.0 Software Protection and Licensing Tutorial: Starter Kit
© 2024 THALES. Allrights reserved. | Revision A | Last updated: 01 May 2024 | Support 20


https://supportportal.thalesgroup.com/csm?id=sentinel

LESSON 4: Defining Products

Objective: Learn how to define the Products you want to license
Roles in this lesson: Product Manager
Applications used: Sentinel LDK-EMS

I NOTE This lesson is not applicable for Sentinel HL Basic keys.

A Productis a licensing entity that represents one of the vendor’'s marketable software products. The Product is
coded into the memory of a Sentinel key and contains one or more Features. License terms are defined for each
Feature in a Product.

Like Features, Products are defined using Sentinel LDK-EMS. Typically, this function is performed by the
Product Manager, and implemented by the software engineer. In a true production environment, a number of
Products might be defined and held in readiness for inclusion in customer entitlements. However, you can define
new Products—mixing and matching Features—at any time.

In this lesson, you define a number of Products. The Products will include license terms for the Bounce and
MyNotepad Features you defined in "Defining Features" on page 14. The Products that you define now will be
included in the entitlements you define in later lessons.

In this lesson, you define the following Products:
> “Bounce_Lite™—A “rental” Product, in which the license expires after three executions

> “Bounce_Full™—A “full-featured” Product, in which the license enables unrestricted access to all the Features
in the program. This Product will be created by duplicating the “rental” Product and modifying the license
terms.

> “MyNotepad_Full’— A “full-featured” Product that enables unrestricted access to all the Features in the
program

NOTE In "Creating and Distributing an Entitlement for Sentinel SL-protected Software" on
page 28, and "Creating and Distributing an Entitlement for Sentinel HL-protected Software" on
page 33 you will assume the role of an end user, and will install licenses and run these Products.
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Defining a Product With an Execution-based License

In this lesson, you define a Product based on the Bounce Feature (ID 50), with a license that enables the
program to be launched three times. Following the third execution, the license must be updated to enable further
use of the program.

To define a Product
1. Launch Sentinel LDK-EMS.

2. From the function bar in the Sentinel LDK-EMS screen, select Catalog > Products. The Products screen is
displayed.

3. Click New Product. The Create Product screen is displayed.
4. Inthe Name field, type Bounce Lite.

5. Inthe Locking Type field, select HL or SL (AdminMode or UserMode). This option enables the protection
type to be determined at the time when each entitlement is defined.

6. Onthe Product Features tabbed page, click Add Features.

7. Onthe Add Features to Product screen, select the check box next to the Bounce Feature and click Add
Features to Product.

8. Onthe Product Features tabbed page, click Configure on the Bounce Feature line to specify the license
terms for the Feature. The Configure License Terms screen is displayed.

9. Inthe License Type field, select Execution Count.
10.Under License Terms:
a. Clear the check box for Specify at entitlement time.
b. Inthe Executions field, type 3.

11.Click Save. The Configure License Terms screen closes and the license terms are displayed in the License
Terms column.

12.Click Save as Complete. The new Bounce_Lite Product is displayed in the Products screen. The status for
the Product is listed as Complete. This indicates that the Product is available for distribution.

Defining Products With Full-Featured Licenses

In this section, you duplicate existing Products in order to define two additional Products:

> A Product based on the Bounce Feature (ID 50), with a perpetual license that will allow the end user unlimited
access to the program. This Product will later be used to update the limited, execution-based Bounce_Lite
Product to a full-featured license.
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A Product based on the MyNotepad Feature (ID 10), with a perpetual license that will allow the end user
unlimited access to the program. In “Defining an Unlocked Trialware Product” on page 25, you will define an
evaluation MyNotepad Product. The MyNotepad_Full Product you define in this lesson will later be used to
update the evaluation license to a full-featured license.

To define the Bounce_Full Product

1.

From the function bar in the Sentinel LDK-EMS screen, select Catalog > Products. The Products screen is
displayed.

Click New Product. The Create Product screen is displayed.
In the Name field, type Bounce Full.

In the Locking Type field, select HL or SL (AdminMode or UserMode). This option enables the protection
type to be determined at the time when each entitlement is defined.

On the Product Feature tabbed page, click Add Features.

On the Add Features to Product screen, select the check box next to the Bounce Feature and click Add
Features to Product.

On the Product Features tabbed page, note that the License Type for the Bounce Feature is Perpetual by
default. Therefore, it is not necessary to perform any additional configuration for the Feature.

Click Save as Complete. There are now two items listed in the Products screen: Bounce_Lite and Bounce _
Full. The status for the Bounce_Full Product is listed as Complete.

To define the MyNotepad_Full Product

1.

From the function bar in the Sentinel LDK-EMS screen, select Catalog > Products. The Products screen is
displayed.

Click New Product. The Create Product screen is displayed.
In the Name field, type MyNotepad Full.

In the Locking Type field, select HL or SL (AdminMode or UserMode). This option enables the protection
type to be determined at the time when each entitlement is defined.

On the Product Feature tabbed page, click Add Features.

On the Add Features to Product screen, select the check box next to the MyNotepad Feature and click Add
Features to Product.

To define memory data, click the Memory tab (next to the Product Features tab), and then do the following:
a. Click New. The New Memory Segment screen is displayed.

b. Inthe Offset field, type 0. (Afterward, this will change automatically to 0x0000).

c. Inthe Length field, type 16.

d. Inthe Text field, type Hello World.
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e. Click Save. The screen closes. In the Memory Map at the bottom of the Memory tabbed page, the content
of the memory is displayed.

8. Click Save as Complete. The Create Product screen closes. The main pane of the Products screen now
contains the three Products that you defined in this lesson: Bounce_Lite, Bounce_Full, and MyNotepad_Full.
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LESSON 5: Defining an Unlocked Trialware
Product

/

Objective: Learn how to define an Unlocked Trialware Product that can be supplied as a
trial product

Roles in this lesson: > Product Manager
> Development

Applications used: Sentinel LDK-EMS

I NOTE This lesson is not applicable for Sentinel HL Basic keys.

In this lesson, still in the Production Management role, you define the “MyNotepad_Evaluation” Product as a trial
version of the “MyNotepad_Full” Product you defined in "Defining Products" on page 21. You then assume the
Development role to prepare the Product for distribution by creating a customized Sentinel Run-time
Environment Installer executable file.

An Unlocked Trialware Product is typically used for evaluation purposes, to enable the provision of a grace
period, or for super-distribution. An Unlocked Trialware Product can be used on any computer for a limited time
period. After the allotted period expires, the software no longer runs unless it is activated with a

Sentinel protection key.

Defining an Unlocked Trialware Product

In this section, in the Production Management role, you define the “MyNotepad_Evaluation” Product—an
Unlocked Trialware Product that is a trial version of the “MyNotepad_Full” Product, with a license that expires
60 days after the application is first used.

To define an Unlocked Trialware Product

1. From the function bar in the Sentinel LDK-EMS screen, select Catalog > Products. The Products screen is
displayed.

2. Inthe list of Products, select the MyNotepad_Full Product.

3. From the task buttons, select Actions > Unlocked. The Create Unlocked Product screen is displayed.

P

In the Name field, type MyNotepad Evaluation. Note that:
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* The Base Product field displays MyNotepad_Full.

* The MyNotepad Feature you defined in "Defining Features" on page 14 is included in the Product with the
Unlocked (Time Period) license type. For an Unlocked Trialware license, the user is granted a usage
period of 30 days by default.

On the Product Features page, click Configure for the MyNotepad Feature.
In the Configure License Terms screen, change the value for Number of Days from 30 to 60.
Click Save. The Configure License Terms screen closes.

Click Save as Complete.

Defining a Bundle of Unlocked Trialware Products

In this section, you assume the Development role. You bundle the “MyNotepad_Evaluation” Unlocked Trialware
Product that was defined by the Product Manager. You then prepare a Sentinel LDK Run-time Environment
Installer executable file. (In a true production environment, you would embed this file in your own application
installer.)

To define a bundle of Unlocked Trialware Products

NOTE For the purposes of this tutorial, ensure that the Download location (described below), if
it exists, does not contain any V2C files at this point.

. From the function bar in the Sentinel LDK-EMS screen, select Developer > Bundle Unlocked Products.

The Bundle Unlocked Products screen is displayed.

. Verify that the correct Batch Code is displayed in the Batch Code field.

Select the task Actions > Add. The Products screen is displayed.

Select the MyNotepad_Evaluation entry and click OK. The Products screen closes and the MyNotepad
Evaluation Product is displayed in the Bundle Unlocked Products screen.

NOTE An Unlocked Products bundle can contain any number of Unlocked Trialware Products.
In this procedure, you are only adding a single Unlocked Trialware Product—MyNotepad_
Evaluation—to the Unlocked Products bundle.

In the Product Details pane, select the check box for the MyNotepad_Evaluation Product.

Click Produce V2C. The V2C file is generated.

Choose the option to save the file. The file is saved to:

%HomePath%\Documents\Downloads\
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NOTE The location to which the file is saved may vary depending on your operating system and
web browser. For the remainder of the lessons in this tutorial, this location is referred to as the
Download location.

Preparing a Sentinel Run-time Environment Installer

Remaining in the Development role, you now prepare a Sentinel Run-time Environment Installer executable that
includes the V2C file you created. (The Installer automatically applies any V2C file located in the same directory.)
The Run-time Environment may be required on the end user’'s computer in order for your Sentinel LDK protected
and licensed program to function correctly. (This depends on the type of protection key that you will be providing.
For this tutorial, you will install the Run-time Environment.)

You need only embed the V2C file and the Installer executable in your software setup to create a ready-to-run
Sentinel LDK-protected and licensed program. In this scenario, you have already specified that the MyNotepad
program will run in Trial mode for a maximum of 60 days.

To prepare a Sentinel Run-time Environment Installer executable

1. A customized Run-time Environment Installer is available on the machine where you ran the Sentinel Master
Wizard earlier. Copy the file haspdinst.exe from the directory %userProfile%\Documents\Thales\Sentinel
LDK10.0\Redistribute\Runtime\ to the Download location described earlier. The Download location now
contains both the Installer and the V2C file.

NOTE Do not execute the generated file at this time! You will install this bundle in "Creating and
Distributing an Entitlement for Sentinel SL-protected Software" on page 28.
You are now ready to ship your Product with its license locked to either:

> aSentinel SL key, as described in "Creating and Distributing an Entitlement for Sentinel SL-protected
Software" on page 28.

OR

> a Sentinel HL key, as described in "Creating and Distributing an Entitlement for Sentinel HL-protected
Software" on page 33.
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LESSON 6: Creating and Distributing an
Entitlement for Sentinel SL-protected
Software

J

Objective: > Learn how to define an entitlement locked to a Sentinel SL key, specify the
customer for the entitlement, and produce the entitlement.

> Simulate a variety of end-user interactions with programs protected by
Sentinel protection keys.

Roles in this lesson: > Entitlement Manager
Production

> EndUser

Applications used: > Sentinel LDK-EMS
Sentinel LDK-EMS Customer Portal
> Admin Control Center

I NOTE This lesson is not applicable for Sentinel HL Basic keys.

In this lesson, you assume the Entitlement Manager role and define an entitlement. For the order process, you also
define the customer and produce the entitlement so that it is ready for shipment.

The entitlement you define is based on the “MyNotepad_Full” Product that you defined in "Defining Products”on
page 21. The license is locked to a Sentinel SL key that will be activated on the end-user’'s machine to convert
the trial MyNotepad software to a full-featured product.

When you defined the Products, you specified the license terms for the Features included within those Products
at that time. Note that instead of specifying the license terms when you defined the Product, you could have
enabled the functionality for specifying the license terms at this stage as part of order processing.

In this lesson, you will also assume the end-user role to install and use the Product. You will then use the
Sentinel SL Product Key received from the vendor to convert a trial version of the software to a full-featured
program.
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NOTE When a customer wants to purchase additional Features or to extend the current license
for a Product that has its license locked to a Sentinel SL key, you can update the deployed
license, as described in "Creating an Update for a License in the Field" on page 36.

Defining a Perpetual License With a Product Key

In this section, you create an entitlement for the “MyNotepad_Full” Product that you defined in "Defining
Products"on page 21, locked to a Sentinel SL key. This license will then be used to convert the trial MyNotepad_
Evaluation Product you defined in "Defining an Unlocked Trialware Product” on page 25 to a full-featured
product.

To define an entitlement with a perpetual license

1. From the function bar in the Sentinel LDK-EMS screen, select Customers. The Customers screen is
displayed.

Click New Customer. The Create Customer screen is displayed.

Ensure that the type Company is selected.

In the Company Name field, type Bob Doe Ltd.

In the Contact Information pane, enter your own (or any other) name and email information.

Click Save. The new customer is listed in the Customer screen.

N o o > 0 Db

From the function bar in the Sentinel LDK-EMS screen, select Entitlements. The Entitlements screen is
displayed.

8. Click New Entitlement. The Create New Entitlement screen is displayed.

9. Inthe Customer field, type Bob.

10.Select Bob Doe Ltd. from the list of customers that appears. The full name of the customer is displayed.
11.In the Product Details pane, click Add Product.

12.1n the Product Selection screen, select the check box for MyNotepad_Full and click Add Product to
Entitlement. The MyNotepad_Full Product is added to the Product list.

13.Select the check box for MyNotepad_Full.

14.For Entitlement Type, ensure that Product Key is selected. Accept all other default values.
15.Click Produce. The Download Product Keys screen is displayed.

16.Click Download.

17.Choose the option to save the Product Keys file. The file is saved to the Download location (described in
"Defining a Bundle of Unlocked Trialware Products " on page 26).

In the Entitlements screen, the new entitlement is displayed with the status Product Keys Generated.
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Installing a Trial Product

In this section, you simulate the experience of the end user when installing and running your MyNotepad “trial”
software program.

Although in a true production environment your software engineer would typically embed the Run-time
Environment installation which includes the trialware license (for trial use) into your software installation so that it
executes as part of the installation process, in this tutorial you perform several installation and simulation steps.

To install the Sentinel Run-time Environment and trialware license on an end-user machine

1.
2,

From the Start menu, select Run.

Click Browse and navigate to the Download location (described in "Defining a Bundle of Unlocked Trialware
Products " on page 26) that contains the RTE Installer (haspdinst.exe) and V2C file that you created earlier.

Select the haspdinst.exe file and click Open. The browse window closes and the file path is displayed in the
Open field.

In the Open field, type a space followed by -1 at the end of the file path.
For example:
"C:\Users\Thomas\Downloads\haspdinst.exe" -1

Click OK. The Sentinel Run-time Environment is installed and a success message is displayed. The V2C file
that is present in Download location together with Run-time Environment Installer is applied automatically to
create the trial license.

To confirm the license status of the trial Product

1.

Navigate to the following folder:
%HomePath%\Documents\Thales\Sentinel LDK 10.0\VendorTools\VendorSuite\Protected
Double-click MyNotepad.exe.

While the application is running, from the Start menu, open Sentinel LDK. In the Sentinel LDK Launcher,
click Additional Tools > Admin Control Center. (The Admin Control Center is part of the Run-time
Environment.)

In the Options pane, select Sentinel Keys. All the Sentinel protection keys that are accessible on the
Sentinel License Manager are displayed.

# Location Vendor Key ID Key Type Version Sessions Actions

0 Laocal Dema MB 1058355007 411405208 SL-Adminhlode 2.00 - |Products | | Features  Sessions || Cerificates
1 Local Master 840659384 Master i 325 - [Features| Sessinns|[Blink nn:

2 Local Master 1720199720 Developer e [ 325 - Features| Sessions || Blink on
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5. Locate the entry for your key and click the Features button in the Actions column. The Features that are
licensed in your key are displayed. Note that the Logins field shows that there is currently one login to
MyNotepad_Evaluation and that the Restrictions field for Feature ID 10 indicates that the 60-day trial has
begun.

6. Close the MyNotepad program.

Notifying the Customer

Sentinel LDK-EMS can be configured so that when you produce an entitiement, Sentinel LDK-EMS
automatically sends an email notification to the customer. This email contains the Product Key and a link to the
Sentinel LDK-EMS Customer Portal.

The Customer Portal is a web portal in your installation of Sentinel LDK-EMS that your customers access to
activate the licenses for their full-featured Products.

A typical email notification looks like this:

Dear Bob Doe,

Congratulations! An entitlament has baen ersatad for vou with the following datails:

Entitlement Details

Start Date: 05/05/2012 End Date:

Customer: Boh Doe Ltd (E-mail: BobDoe@safenet-inc.com)

Channel Partner:

Product key: 02372210-68£6-4£f7-0420-a8fd64bdf2aa Quantity (per product key):
Products

Name Lock Type

MyNotepad Full SL-AdminMode

Mow, follow the stzps given balow to activats and manage vour entitlament(s):
1. Aecass the Entitlement Managsment Svstem at http:/localhost: 2080/ sms customer] ogin. html.

2. Log on using product kay given abova,

This notification provides all the information that the customer needs to activate the Product.

To simplify this tutorial, we did not configure Sentinel LDK-EMS to send email notifications, so we will simulate
the end-user experience.

Activating a License With a Product Key

In this section, still in the role of the end user, you assume that you have purchased the MyNotepad_Full
program and received an email notification from the vendor. You use the Product Key to convert the trial version
of the software to a full-featured program that is locked to your machine.
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To activate the protected program

1. To access the Customer Portal, the customer would click a link provided in the email notification.
To simulate this action, click the link below or enter the URL in your Web browser address field:
http://localhost:8080/ems/customerLogin.html
The Sentinel LDK-EMS Product Key Login screen is displayed.

2. The customer would copy the Product Key from the email notification and paste it into the Product Key field
in the login screen. To simulate this action, open the .txt file that contains the Product Key you generated
earlier in this lesson in "Defining a Perpetual License With a Product Key" on page 29. This file can be found
in the Download location described in "Defining a Bundle of Unlocked Trialware Products " on page 26.

Copy the Product Key from the file and paste it into the Product Key field in the login screen. Click Login.

The Sentinel LDK-EMS Activation screen is displayed. This screen contains information about the
entitlement. If the entitlement allows multiple activation, this screen indicates how many activations remain.

The customer can choose to perform online activation or offline activation.

Offline activation can be used if the license will be installed on a machine from which it is not possible to
access the Customer Portal. This includes downloading a utility from Sentinel LDK-EMS and transferring files
manually to and from the target machine.

Most customers will prefer to use online activation.

3. Click Online Activation. A progress indicator is displayed for a few seconds, followed by the message
Activation installed successfully.

4. This marks the end of the activation process. Click Close to dismiss the notice.

5. Open Sentinel Admin Control Center to see that you now have a Perpetual license for Feature ID 10.
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LESSON 7: Creating and Distributing an
Entitlement for Sentinel HL-protected
Software

Objective > Learn how to define an entitlement locked to Sentinel HL keys, specify the
customer for the entitlement, and produce the entitlement

> Simulate a variety of end-user interactions with programs protected by
Sentinel protection keys

> Learn how to update a license in the field

Role in this lesson > Entitlement Manager
Production
> EndUser
Applications used > Sentinel LDK-EMS

Admin Control Center

I NOTE This lesson is not applicable for Sentinel HL Basic keys.

In this lesson, you assume the Entitlement Manager role and define two different customer orders. For the order
process, you define an entitlement, define a new customer, and produce the entitlement so that it is ready for
shipment. You also assume the end-user role to test different types of Sentinel protection keys and licenses.

When a customer wants to purchase additional Features, or to extend the current license for your protected
program, you can update the deployed license without having to recall or redeploy keys.

In this lesson, you will also assume the Entitlement Manager role and learn how to update the deployed license.

The entitlements that you define are based on the Products that you defined in "Defining Products"” on page 21,
and include:

> An entitlement for the Bounce_Lite Product.

> An entitlement for the Bounce_Full Product. This entitlement will be used to update the license on the
Sentinel HL key provided to the end user with the Bounce_Lite Product. You will learn how to convert its
functionality from Bounce_Lite to Bounce_Full in the field.
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When you defined the Products, you specified the license terms for the Features included within those Products
at that time. Note that instead of specifying the license terms when you defined the Product, you could have
enabled the functionality for specifying the license terms at this stage as part of order processing.

Defining a “Rental” Product Entitlement With Sentinel HL Locking

In this section, you define an entitlement for the Bounce_Lite Product, with its license locked to a Sentinel HL
key.

To produce a Sentinel HL key-based entitlement for a customer

1. From the function bar in the Sentinel LDK-EMS screen, select Customers. The Customers screen is
displayed.

In the Batch Code field, ensure that your Batch Code is selected.

Click New Customer. The Create Customer screen is displayed.

Ensure that the type Company is selected.

In the Company Name field, type John Smith Ltd.

In the Contact Information pane, enter your own (or any other) name and email information.

Click Save. The new customer is listed in the Customer screen.

© N o o » v DN

From the function bar in the Sentinel LDK-EMS screen, select Entitlements. The Entitlements screen is
displayed.

9. Click New Entitlement. The Create New Entitlement screen is displayed.

10.In the Customer field, type John.

11.Select John Smith Ltd. from the list of customers that appears. The full name of the customer is displayed.
12.In the Product Details pane, click Add Product.

13.In the Product Selection screen, select the check box for Bounce_Lite and click Add Product to
Entitlement. The Bounce_Lite Productis added to the Product list.

14.Select the check box for Bounce_Lite.
15.For Entitlement Type, select Hardware Key.
16.1n the Number of keys field, type 1.
TIP At this point, you can “queue” the entitlement. The procedure that follows could then be

performed by a person in the Production role, who is authorized to use Sentinel LDK-EMS only
for the purpose of burning licenses to HL keys and does not have access to other functions.
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To lock the license to a Sentinel HL key

1.

2
3.
4

Connect the Sentinel HL key to which you want to burn the entitlement to your computer.

. Click Produce. The Produce Sentinel HL Key screen is displayed.

In the list of keys, select the check box for your Sentinel HL key.

. Click Burn. A graphical display indicates that the burn is taking place. Upon completion, a success message

is displayed.
Close the Update Physical Key screen.

Using an Application With a Sentinel HL Key

When a customer receives an application that you protected with a Sentinel HL key, the actual key must be
accessible by the application in order to run the program. In the following procedure, you assume the end-user
role to test Bounce, with a Bounce_Lite license locked to a Sentinel HL key.

In this part of the lesson, you use Sentinel Admin Control Center to manage the use of your licensed software. In
a true production environment, a system administrator in your customer’s organization uses this Web-based
application to manage network licenses for your software.

To operate a Product protected with a Sentinel HL key

1.

Connect the Sentinel HL key on which you burned the entitlement to your computer. The required licensing
information for Bounce_Lite is contained, in encrypted format, in the key. As long as the license is valid, the
protected application can run.

(Optional) Examine the license on the HL key as follows:

a. From the Start menu, open Sentinel LDK. The Sentinel LDK Launcher is displayed. In Sentinel LDK
Launcher, click Additional Tools > Admin Control Center. Sentinel Admin Control Center is displayed.
This interface enables customers to track the status and usage of their Sentinel licenses.

b. Inthe Options pane, select Sentinel Keys. All the Sentinel protection keys that are accessible on the
Sentinel License Manager are displayed.

# Location Vendor Key ID Key Type Version Sessions Actions

0 Local Dermo MB 1058355007411405208 SL-Admintode 2.00 - |Products| [Features || Sessions| | Certificates|
1 Local Master 840559384 Master B = 325 - |Features | Sessions || Blink on

2 Local Demo MB 2136683878 HL MetTirme 250+ - 325 - [Features| | Sessions| [Blink on

c. Locate the entry for your Sentinel HL key and click the Features button in the Actions column. The
Features that are licensed in your key are displayed.

Note that the Restrictions field for Feature ID 50 displays Executions 3 left, indicating that the remaining
number of logins permitted by the license is 3.
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Navigate to the following folder:

%HomePath%\Documents\Thales\Sentinel LDK 10.0\VendorTools\VendorSuite\Protected
Double-click Win32_Bounce.exe. The Bouncing Ball program launches.

Close the Bounce software.

Repeat step 4 and step 5 two more times, to consume all the permitted executions.

Repeat step 4. Bounce fails to open and a message is displayed indicating that the Feature has expired.

In Sentinel Admin Control Center, in the Options pane, select Sentinel Keys. All the Sentinel protection keys
that are accessible on the Sentinel License Manager are displayed.

Locate the entry for your Sentinel HL key and click the Features button in the Actions column.

TIP If you are not sure which entry relates to your specific key, click the Blink on button and
identify the key on which the LED is blinking.

Note that the Restrictions field for Feature ID 50 displays Expired, meaning that the number of allowed
logins defined in the license has been exhausted.

Creating an Update for a License in the Field

John Smith requested a license upgrade—from Bounce_Lite to Bounce_Full. In this part of the lesson, you will
assume the Order Management role to create an update for the deployed license, and the Production role to
produce the entitlement for the updated license. You will then assume the role of the end user (John Smith) to
activate the license update.

To produce an entitlement for a license update

1.

o o » 0 N

8.
9.

From the function bar in the Sentinel LDK-EMS screen, select Entitlements. The Entitlements screen is
displayed.

Click New Entitlement. The New Entitlement screen is displayed.

In the Customer field, type John.

Select John Smith Ltd. from the list of customers that appears. The full name of the customer is displayed.
In the Product Details pane, click Add Product.

In the Product Selection screen, select the check box for Bounce_Full and click Add Product to
Entitlement. The Bounce Full Productis added to the Product list.

Select the check box for Bounce_Full.
For the Entitlement Type, select the Protection Key Update option.

Click Locate. The Located Sentinel Keys screen is displayed.

10.Select Key ID, and then click Locate. The key information is displayed in the upper table.
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11.1n the list of protection keys, select the check box for John Smith’s Sentinel HL key.
12.Click Add To List. The selected key is added to the Sentinel Keys to Update table.

13.In the Sentinel Keys to Update table, select the check box for John Smith’s Sentinel HL key; then click OK.
The Locate Sentinel Keys screen closes.

14.Click Produce. The Generate License screen is displayed.

15.In License Output Type, select the V2C option.

16.Click Generate. The message V2C generated successfully is displayed at the top of the screen.
17.1n the Activation Details pane, click Download V2C File. Save the file to your desktop.

The file saved is named [KeylID].v2c, where [KeylID] is Key ID of the Sentinel HL protection key for which the
license was generated.

18.Click Close. The Generate License screen closes.

Updating a License at the Customer’s Site

In this section, you retain the role of “John Smith Ltd.” You have purchased a full-featured version (Bounce_Full)
of the program to replace the execution-based Bounce_Lite version. You update your license using the
Sentinel Admin Control Center and the HaspUpdate.v2c file you receive from the vendor.

To apply a license update
1. Ensure that the appropriate Sentinel HL key is connected to your computer.
2. Launch Sentinel Admin Control Center, as follows.
a. From the Start menu, open Sentinel LDK. The Sentinel LDK Launcher is displayed.

b. From the navigation pane, click Additional Tools > Admin Control Center. Sentinel Admin Control
Center opens.

3. Inthe Options pane, select Update/Attach. The Update/Attach License window is displayed.
4. Click Browse and navigate to your desktop.

5. Select the [HASP KeylD].v2c file that you created when producing the entitlement for the license update in
your Entitlement Manager role earlier, in step 17 in "Creating an Update for a License in the Field" on the
previous page.

Click Open. The file path is displayed in the Select a V2C... file field.
Click Apply File. A message is displayed confirming that your update was applied successfully.

In the Options pane, select Sentinel Keys.

© ® N @

Locate the entry for your Sentinel HL key and click the Features button. The Features that are licensed in
your key are displayed.
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Note that an additional row is created for Feature ID 50. The Restrictions field in this row is Perpetual,
indicating that the remaining number of logins permitted by the license is unlimited.

10.Navigate to the following folder:
%HomePath%\Documents\Thales\Sentinel LDK 10.0\VendorTools\VendorSuite\Protected
11.Double-click Win32_Bounce.exe. The Bouncing Ball program launches.

12.Close the Bouncing Ball program and disconnect the Sentinel HL key.

NOTE This lesson demonstrates using Sentinel Admin Control Center to examine licenses
and to update a license at the customer’s site.

Sentinel Admin Control Center is part of the Sentinel LDK Run-time Environment. The Run-
time Environment was placed on your computer when you installed Sentinel LDK Vendor
Tools. However, the Run-time Environment is not required for Sentinel HL Driverless keys.

If you have notincluded the Run-time Environment with your protected application, you can
update licenses at the customer’s site using other methods. For more information, see the
description of the Sentinel Remote Update System in the Sentinel LDK Software Protection
and Licensing Guide.
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LESSON 8: Using Sentinel Licensing AP

Applications used Sentinel LDK ToolBox

Objective Learn how to implement Sentinel Licensing API
functions using Sentinel LDK ToolBox

Role in this lesson Development

Now that you have completed the other lessons in this tutorial, you should have a good understanding of how
Sentinel LDK works. This lesson builds on your accumulated knowledge and introduces you to the Sentinel
Licensing API through Sentinel LDK ToolBox, which is an interactive GUI application that helps you familiarize
yourself with various Sentinel APIs.

The Sentinel LDK system offers a rich variety of API calls to support customized protection of your program, as
well as other operations on Sentinel protection keys.

You can also use Sentinel LDK ToolBox to generate source code that you can immediately copy and paste into
your own application source code.

The Sentinel LDK ToolBox window contains these elements:

>

>

API panel, in which you select the API to work with

Function pane, in which you select the function to perform

Display pane, in which you can view and edit the details of the function call you selected

Generated Code pane, in which code is displayed. You can copy this code and paste it into your own files.

Handles pane, in which the session handle is displayed
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To launch Sentinel LDK ToolBox
1. From the Start menu, open Sentinel LDK. The Sentinel LDK Launcher is displayed.

2. Click ToolBox to launch the Sentinel LDK ToolBox application. The Sentinel LDK ToolBox main window is
displayed.
The API panel on the left of the ToolBox window contains all the available APls. For the selected API, the
available functions are displayed.

3. Browse the list. You can select any API, and then select an available function for that API. After you select a
function, the Display pane on the right of the ToolBox window displays the parameters that you must specify
in order to execute the function call.

Selecting Your Programming Language

Sentinel LDK ToolBox can generate code in several programming languages.

To select your programming language
1. From the File menu in Sentinel LDK ToolBox, select Settings. The Settings window is displayed.
2. Select the ToolBox tab.

3. From the Programming language list, select your preferred language.

NOTE For this tutorial, it is recommended that you select C-API. If C-APlI is not selected, select
it and click OK. If C-APl is already selected, click Cancel.
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The Settings window closes with the programming language selected.

Starting With Login

Each Sentinel Licensing API session typically begins with the hasp_login API call, which establishes a
connection with a Sentinel protection key and enables access to its resources. For this lesson, you will connect a
Sentinel HL key.

NOTE hasp_get_info() and hasp_update() are standalone functions. You do not have to log
in before you call these functions.

To log in to the Sentinel HL key
1. Connect a Sentinel HL key.

2. Inthe Function pane, select hasp_login. The Display pane displays all the parameters with the default
values that are appropriate for the login operation.

3. Specify the location of your stored Vendor Code file.
To locate your Vendor Code file, click the browse button.
By default, Vendor Codes are stored in:
%HomePath%\Documents\Thales\Sentinel LDK 10.0\VendorCodes

The file is named according to the label printed on your keys. For example, if the keys are labeled with Batch
Code ABCDE, by default, your Vendor Code file is named ABCDE.hvc.

4. Select your Vendor Code file and click Open. The code is displayed in the Vendor Code field.
5. Inthe Feature ID field, type 50.

You must specify a Feature ID that exists in the protection key. If you did not define Feature ID 50 earlier in
the tutorial or if you are using a Sentinel HL Basic key, select 0 in the Feature ID field.

6. Atthe bottom left of the hasp_login pane, click Execute. The result of the executed login is summarized to
the right of the Execute button in three Status fields—number, code and message.

Encrypting Data and Writing to Memory

Now that you have established a session with the connected Sentinel protection key, you can access its resources
through other API calls.

One of the most important and powerful resources available in a Sentinel protection key is its internal encryption
engine. You can optimize protection by using this engine and the encryption facilities in Sentinel LDK as an
additional method for verifying that the correct key is accessible when the protected program is running. To do
this, proceed as follows:
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> Encrypt a string using the Sentinel protection key
> Incorporate the encrypted string into the application source code
> Define your source code to send the encrypted string to the key for decryption and then to verify the result

In its encrypted form, the string prevents the program from running correctly. The protected program will run only
if it can decrypt the string, and this can only be achieved if the Sentinel protection key is accessible. This section
demonstrates how the key encrypts and decrypts a string.

To encrypt a string

1. Inthe Function pane, select hasp_encrypt. The Display pane displays parameters for the hasp_encrypt
API call.

2. Specify the Size as 100.

3. Click the first dot to the right of the memory editor, on the far right of the window, and type: Sentinel LDK.

4. Click Execute. Note that the string has been encrypted by the Sentinel protection key and is now illegible.
NOTE Sentinel LDK uses a unique encryption key for each encryption process, based on your
unique Sentinel Vendor keys and the current Feature. Therefore, the string you type is encrypted
differently from any other software vendor (and differently for each Feature).

5. Inthe Function pane, select hasp_decrypt. The editor still displays the encrypted string.

6. Click Execute. The Sentinel protection key decrypts the string. Sentinel LDK is now displayed in the editor.

NOTE If you are using a Sentinel HL Basic key, you have completed the tutorial. Proceed to
"What's Next?" on the next page.

Retrieving Sentinel Protection Key Information

Sentinel LDK ToolBox enables you to retrieve key-related information. In this section, you use the hasp_get_
sessioninfo function to retrieve information relating to the identity and memory size of the Sentinel protection
key.

To retrieve Sentinel protection key information

1. Inthe Function pane, under Management, select hasp_get_sessioninfo. The Display pane displays
parameters for the hasp_get_sessioninfo API call.

2. Inthe Display pane, from the Format Template list, select HASP_KEYINFO. Note that a description of the
Format definition is displayed in the gray box below the Information field.

3. Click Execute. The Information pane displays XML tags with information on the key, including:

* The unique ID number of the connected key
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* The key Read/Write memory size

* The key Read-only memory size

Reading and Programming Sentinel Protection Key Memory

In this section, you log in to Feature ID 10 on the Sentinel SL key that you defined in "Defining Products” on
page 21. You write to and then read from the memory of the protection key.

To log in to the Sentinel protection key

> Follow the Sentinel HL key login procedure on "To log in to the Sentinel HL key" on page 41, but this time, in
step 5, type 10.

To program the Sentinel protection key memory

1. In the Function pane, under Memory, select hasp_write. The Display pane displays parameters for the
hasp_write API call and an editor for the Sentinel protection key memory.

2. Inthe memory editor, set the Offset field to 16 and the Length field to 24.

3. Ontheright side of the pane, click the first “.” and type:
The World says Hello

4. Click Execute. The string is stored in the protection key memory.

To read the Sentinel protection key memory

1. In the Function pane, under Memory, select . The Display pane displays parameters for the hasp_read API
call and an editor for the Sentinel protection key memory.

2. Inthe memory editor, set the Offset field to 0 and the Length field to 40.
3. Click Execute. The memory editor now displays:
» the string Hello World, which you stored in the key in "Defining Products" on page 21.

* the string that you typed in the procedure above, in step 3.

What’s Next?

This concludes the Sentinel LDK tutorial. You are now ready to use Sentinel LDK applications to license your
software and protect it against unauthorized use.

For additional information about the Sentinel LDK system, refer to the Sentinel LDK Software Protection and
Licensing Guide and to the Help documentation available in the Sentinel LDK applications.
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